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DIRECTOR’S MESSAGE 

It is with great pleasure that I present the e-Manual for the 5-Day Offline 

Workshop on “Skill Enrichment in Vocational Education: Practical Learning 

with ATL & STEAM” designed for TGTs (Work Education). This workshop 

reflects our continued commitment to fostering skill-based, innovative, and 

experiential learning in alignment with the goals of the National Education 

Policy (NEP) 2020 and the National Curriculum Framework for School 

Education (NCF-SE). 

In today’s rapidly evolving educational landscape, integrating Vocational 

Education with platforms like Atal Tinkering Labs (ATL) and STEAM 

(Science, Technology, Engineering, Arts, and Mathematics) is critical for 

equipping students with real-world competencies, problem-solving abilities, 

and a spirit of innovation. This workshop aims to empower Work Education 

teachers with hands-on tools, interdisciplinary strategies, and practical 

methodologies to transform classrooms into dynamic spaces of creativity and 

applied learning. 

I extend my heartfelt appreciation to the Associate Course Director, expert 

Resource Persons, participants, Training Associates, and the Workshop 

Coordinator for their enthusiastic participation and thoughtful contributions. 

Their collective efforts have made this initiative a rich and meaningful 

professional learning experience. 

Wishing you all an enriching and transformative journey ahead! 

MENAXI JAIN   

                                                                                                DIRECTOR   

                     ZIET MYSURU         
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INTRODUCTION: 

A five-day offline workshop titled “Skill Enrichment in Vocational Education: Practical 

Learning with ATL & STEAM” was conducted from 11th to 15th August 2025 for TGT (Work 

Experience) teachers. The workshop aimed to strengthen participants’ pedagogical approaches, 

enhance hands-on skills, and integrate Atal Tinkering Lab (ATL) and STEAM-based learning 

methodologies into vocational education. In alignment with the National Education Policy (NEP) 

2020, the programme emphasized practical, experiential, and interdisciplinary learning to improve 

classroom engagement and foster skill development. 

During the workshop, participants explored innovative teaching strategies, activity-based 

learning modules, and effective assessment techniques designed to cultivate creativity, problem-

solving, and 21st-century competencies among students. The programme was meticulously planned 

and executed under the guidance of esteemed leadership, with Ms. Menaxi Jain, Director of ZIET 

News, serving as Course Director, Sh. Davinder Singh, Principal of KV Chamrajnagar, as Associate 

Course Director, and Sh. D. Sreenivasulu, TA (Mathematics) at ZIET Mysuru, as Course 

Coordinator. The resource persons, Sh. S. A. Bhende, TGT (WE), KV Belagavi Cantt, and Sh. 

Prashant Kumar, TGT (WE), KV Krishnarajapuram, facilitated the sessions. 

The workshop was attended by twenty-five participants from the region, bringing the total 

number of attendees, including organizers, to twenty-seven (Annexure 1). The programme focused 

on fostering a standardized and optimized approach to integrating ATL and STEAM-based practical 

learning into vocational education. To ensure active collaboration and effective utilization of time, 

participants were evenly divided into five groups. Each group was pre-assigned specific pedagogical 

themes and practical demonstration activities aligned with ATL and STEAM concepts, which 

enabled hands-on engagement, peer learning, and the development of innovative classroom 

strategies. 

 

Objectives of the Workshop 

 

The primary objectives of the workshop were centered on enhancing teachers’ understanding of 

vocational education, developing practical competence with tools and technology, and integrating 

STEAM and project-based learning into classroom teaching. Firstly, the workshop aimed to 

strengthen participants’ conceptual clarity regarding vocational education, including its aims, scope, 

and its role in nurturing 21st-century skills among students. Teachers were equipped with knowledge 

of diverse pedagogical methodologies, activity-based learning strategies, and effective assessment 



techniques tailored specifically for vocational subjects. Participants were also familiarized with the 

Kaushal Bodh Vocational Education Book, gaining insights into its structure, content, and practical 

ways to integrate it effectively into classroom teaching for Classes VI–VIII. The sessions promoted 

innovative teaching practices that encourage creativity, critical thinking, and problem-solving skills 

in students. 

Secondly, the workshop focused on developing hands-on competence with tools, machines, and Atal 

Tinkering Lab (ATL) equipment. Participants received experiential training in the safe operation 

and practical use of essential tools, machines, and laboratory equipment required for vocational 

education. The programme aimed to build participants’ confidence in guiding students through 

hands-on activities and technical demonstrations. Modern technological resources, such as IoT 

devices, sensors, microcontrollers (Arduino, ESP32), and AI-enabled tools, were introduced to 

enable teachers to mentor students in designing and executing innovative projects. Emphasis was 

placed on safety standards, troubleshooting techniques, and sustainable practices while working 

with equipment. 

Finally, the workshop emphasized the integration of STEAM (Science, Technology, Engineering, 

Arts, and Mathematics) and project-based learning into teaching practices. Strategies were 

demonstrated to meaningfully connect STEAM concepts with vocational education to enhance 

interdisciplinary learning. Teachers were encouraged to design and implement project-based 

learning activities that bridge theoretical knowledge with practical applications. Real-life examples, 

including smart home automation, hydroponics-based farming, coding for problem-solving, and 

creative design projects, were showcased to reflect sustainable and future-ready solutions. The 

workshop aimed to foster a classroom environment where students actively participate, collaborate, 

and innovate through hands-on projects that mirror real-world challenges. 

      

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

Day 1 : 11.08.2025  

 
The first day of the workshop commenced with a prayer, creating a serene and harmonious 

atmosphere for the programme. Mr. D. Sreenivasulu, TA (Mathematics) and Course Coordinator, 

extended a warm welcome to all participants and formally introduced the dignitaries and resource 

persons. 

The inaugural session was graced by the esteemed presence of Hon’ble Deputy Commissioner, 

Madam Ms. Menaxi Jain; Sh. Davinder Singh, Principal of KV Chamarajanagar and Associate 

Course Director; Mr. S. A. Bhende, Resource Person; and Mr. Prashant Kumar, Resource Person. 

Sh. Davinder Singh provided a brief overview of the workshop, highlighting its objectives, schedule, 

and anticipated learning outcomes. 

Following this, Hon’ble Deputy Commissioner, Madam Ms. Menaxi Jain, addressed the 

gathering and engaged participants in an interactive session. She shared her vision for the effective 

implementation of vocational education in Kendriya Vidyalayas, emphasizing the importance of 

blending innovation with practicality in classroom teaching. In her inspiring remarks, Madam Jain 

encouraged participants to adopt creative and experiential teaching practices, integrate skill-based 

learning into regular classroom activities, and focus on nurturing problem-solving abilities among 

students. She highlighted that vocational education, when implemented effectively, can play a 

pivotal role in fostering creativity, hands-on competence, and holistic development, thereby 

preparing learners to meet the demands of a rapidly evolving world. 

The morning session was conducted by Mr. Prashant Kumar, Resource Person, on “Understanding 

Vocational Skills for Work Education: Importance of Vocational Skills in Modern Education and 

Sample Portfolio”. The session provided participants with insights into the significance of 

vocational education in the contemporary learning environment. Mr. Kumar emphasized the 

development of practical competencies, hands-on skills, and the preparation of student portfolios to 

document learning outcomes effectively. 

Mr. G. V. Prasad conducted a session on “Kaushal Bodh: Vocational Education & Assessment”. This 

session familiarized participants with the structure and content of the Kaushal Bodh Vocational 

Education Book and highlighted effective methods for integrating it into classroom instruction. 



Emphasis was given to assessment techniques, documentation of learning, and strategies to track 

students’ skill development. 

The afternoon session was led by Mr. Harikumar A and focused on “Integrating 21st Century Skills 

in Vocational Education”. Participants were guided on incorporating critical thinking, creativity, 

collaboration, and problem-solving skills into vocational learning activities. Real-life examples and 

interactive discussions encouraged participants to design lessons that bridge theoretical knowledge 

with practical application. 

The final session of the day provided a hands-on experience with Generative AI Tools, facilitated 

by Mr. Joyce Sabestian. Teachers explored modern AI-based tools and applications relevant to 

vocational education, gaining practical skills in leveraging technology to enhance student 

engagement and learning outcomes. 

Overall, Day 1 combined conceptual understanding, practical training, and technology integration, 

setting a strong foundation for the subsequent workshop days. Participants actively engaged in 

discussions, asked questions, and reflected on ways to implement innovative teaching practices in 

their respective schools. 

 

Day 2 (12.08.2025) Report 

 

The second day of the workshop began with the morning assembly presented by Group 1. The 

programme included a prayer, thought for the day, news updates, a special item, and a recap of the 

previous day’s proceedings. This was followed by an orientation by Sh. D. Sreenivasulu, TA 

(Mathematics), ZIET Mysuru, who outlined the day’s schedule and training expectations. 

Sh. Davinder Singh, Principal and Associate Course Director, addressed the participants and 

highlighted the vital role of Work Education teachers in vocational learning. He emphasized the 

need to align vocational education with the formal education system, particularly through the 

effective implementation of Kaushal Bodh. 

 

Mr. S. A. Bhende, TGT WE, KV No.2 Belagavi, conducted a detailed session on the systematic 

arrangement and display of tools and equipment in vocational labs. He covered materials across 

diverse domains such as gardening, carpentry, electrical, plumbing, electronics, Arduino, ESP32, 

and robotics. His insights provided participants with a clear roadmap to organize and optimize 

vocational labs effectively. 

Special Glimpse: Mega Tinkering Day 

Participants witnessed live glimpses of the nationwide Mega Tinkering Day programme. This 

exposure to large-scale innovation practices offered fresh ideas and inspiration for fostering 

creativity in schools. 

 

Mr. D. Manohar explained the establishment of ATL facilities and the opportunities they provide 

through projects and competitions. He also demonstrated a PIR Motion Sensor project, highlighting 

its practical applications within ATL activities. 

Mr. Anjaneyulu, TGT WE, PM SHRI KV Hebbal, delivered an engaging session on retrofit wiring 

techniques using sensors and Google Assistant. His project integrated IR and PIR sensors into a 



home automation system. The demonstration received appreciation from participants, resource 

persons, and the Associate Course Director. 

 

Mr. Joyce Sebastian, TGT WE, PM SHRI KV AFS, introduced the ESP32 microcontroller and 

showcased IoT-based applications. Participants engaged in coding and circuit simulation to control 

LEDs, explored the WOKWI Simulator, and observed a weather monitoring project using DHT11 

and ESP32. The hands-on session enhanced teachers’ confidence in IoT integration. 

 

Conclusion 

The day’s proceedings were coordinated by Mr. Prashant Kumar, Resource Person and TGT WE, 

KV Krishnarajapuram. Day 2 concluded successfully, blending theoretical knowledge, practical 

demonstrations, and live project experiences. Participants gained comprehensive exposure to 

vocational lab practices, ATL innovations, home automation systems, and IoT applications, leaving 

them motivated to implement similar projects in their schools. 

 

Day 3 (13.08.2025)  

 

The third day of the workshop began with the morning assembly presented by Group 2. The team 

led the proceedings with a prayer, thought for the day, news updates, and a recap of the previous 

sessions, setting a positive and enthusiastic tone for the day. 

The session was graced by the presence of Ms. Menaxi Jain, Deputy Commissioner & Director, 

ZIET Mysuru, who interacted warmly with the participants. She enquired about their well-being, 

the quality of stay and food arrangements, and their overall learning experience from the previous 

two days. She further motivated the participants to implement the Smart Home Automation Retrofit 

Project in their schools and encouraged them to actively engage students and teachers in exploring 

opportunities provided by ATL, Vocational Education (VE), and Work Education (WE) labs. 

 

Hands-on Activities- Line Follower Rover, Bluetooth-Controlled Car, and IoT Applications using 

NodeMcu 

The session, conducted by Mr. Abhishek Prajapath (KV No. 2 Jalahalli) and Mr. Rohit Dariya (KV 

Chamarajanagar), began with step-by-step guidance on installing USB drivers and understanding 

the HC-05 Bluetooth Module. Participants explored its configuration, pin connections, and working 

principles. The hands-on wiring and coding activities enabled them to successfully build Bluetooth-

controlled cars—an engaging project that highlighted the impact of project-based learning. 

 

Effective Implementation, Documentation, and Evaluation of Projects and Portfolios under the 

NCERT Kaushal Bodh Book 

Dr. C. S. Anupama (WE Art & Crafts, DMS RIE Mysuru) emphasized the philosophy of Learning 

by Doing and the role of experiential learning in the NCERT Kaushal Bodh programme. Through 

a vibrant, activity-based session, participants engaged in block printing and tie & dye making. The 

session not only promoted creativity but also demonstrated how vocational education can be 

integrated with art and craft. 



Hydroponics 

Mr. D. Manohar (TGT WE, KV RWF Yelahanka, Bengaluru) delivered a detailed presentation on 

hydroponics, explaining its fundamental concepts, cultivation systems, and significance in 

sustainable agriculture. His session encouraged participants to explore eco-friendly alternatives that 

can be effectively implemented in schools as part of vocational projects. 

 

Projects with Arduino Uno 

The session on Arduino Uno, conducted by Mr. Panga Gangadhar, offered participants an in-

depth, hands-on learning experience with microcontroller-based applications. Beginning with the 

basics of Arduino, he explained the hardware components, pin configurations, and coding 

environment. Participants were guided step by step through simple circuits such as controlling 

LEDs, followed by more advanced applications that integrated sensors and real-world problem-

solving. The practical demonstrations highlighted how Arduino can be effectively used to teach 

programming, electronics, and automation in schools. By the end of the session, participants 

gained greater confidence in designing and implementing Arduino-based projects, making the 

session both highly informative and inspiring for classroom use.. 

 

Bluetooth Car Practical and Competition 

The concluding activity allowed participants to refine their Bluetooth-controlled car projects, 

culminating in a lively Car Race Competition. The event fostered teamwork, innovation, and 

healthy competition. It was witnessed by Ms. Menaxi Jain along with the faculty members of 

ZIET Mysuru, who appreciated the creativity and enthusiasm displayed by the participants. 

 

Conclusion 

The third day concluded on a high note with remarks from Sh. Davinder Singh, Principal, KV 

Chamarajanagar & Associate Course Director, who commended the participants for their active 

engagement and dedication. The sessions offered a balanced blend of technical skills, creative 

expression, and practical applications, ensuring that participants not only gained knowledge but also 

experienced the joy of hands-on learning. 

 

Day 4 (14.08.2025)  

 

The fourth day of the workshop commenced with a morning assembly conducted by Group 3, which 

set a positive and energetic tone for the day’s proceedings. 

Special Address by Director, ZIET Mysuru 

Following the assembly, Smt. Menaxi Jain, Director, ZIET Mysuru, delivered an insightful talk on 

implementing hands-on activities in schools. Referring to projects such as the Bluetooth-

controlled car, she emphasized strategies for guiding students in exploring practical learning and 

integrating innovative activities into classroom practices. 

Subsequently, Sh. D. Sreenivasulu, TA (Mathematics), ZIET Mysuru, engaged the participants with 

a mathematical anecdote, illustrating how Aryabhata referenced his own date of birth in relation to 

the Kalyuga timeline—adding both historical depth and intellectual curiosity to the audience. 



The day’s technical journey began with Sh. Prashant Kumar, TGT (WE), KV KR Puram, who 

introduced participants to Scratch, a block-based visual programming platform. He clarified 

essential programming concepts and demonstrated how Scratch can be used to nurture logic, 

problem-solving, and creativity among students. 

 

Continuing with Scratch, Sh. Prashant Kumar guided participants through hands-on game 

development. They designed interactive projects step by step, discovering how game-based learning 

can foster computational thinking and actively engage learners in classrooms. 

In another engaging session, Sh. Panga Gangadhar demonstrated the creation of a traffic light system 

using Arduino Uno. Teachers practiced coding for LEDs, sequencing traffic signals, and simulating 

real-world traffic control. The activity highlighted how electronics and coding can be seamlessly 

integrated into STEM-based vocational projects. 

 

The focus then shifted to sustainability, with Sh. S. A. Bhende, TGT (WE), KV No. 2 Belagavi, and 

Sh. Kistaiah Ausali leading a session on kitchen gardens and plant nurseries. They emphasized eco-

friendly practices, explaining objectives, soil preparation, vermicomposting, seed sowing, necessary 

tools, and techniques for effective nursery management. 

Complementing these discussions, participants presented their own innovative projects: 

• Ms. Pallavi Singh showcased an IR sensor–based laser beam project. 

• Ms. Vandana Agarwal displayed a decorative LED lighting project. 

• Sh. Shiv Kumar presented eco-friendly plates crafted from paper. 

These participant-led demonstrations highlighted creativity, sustainability, and the integration of 

vocational skills into practical contexts. 

 

Conclusion 

Day 4 offered participants a diverse blend of experiences—ranging from digital creativity through 

Scratch programming and electronic applications with Arduino to sustainable practices in gardening 

and innovative participant-led projects. These sessions reflected the multifaceted scope of 

vocational education, where technology, sustainability, and creativity converge. 

The day concluded with closing remarks by Sh. Davinder Singh, Principal, PM Shri KV 

Chamarajanagar & Associate Course Director, who encouraged participants to adopt these practices 

in their schools and ensure vocational education remains hands-on, innovative, and impactful in 

shaping students’ holistic development. 

 

Day 5 (15.08.2025)  

 

Independence Day Celebration and Workshop – Day 5 

Since the final day of the workshop coincided with Independence Day, all organizers of ZIET and 

participants gathered at 8:30 a.m. to celebrate the occasion. Ms. Menaxi Jain, Director, ZIET 

Mysuru, and Mr. Davinder Singh, Principal, KV Chamarajanagar & Associate Course Director, 

graced the event and addressed the gathering. 



The celebration featured a solo patriotic song by Mr. Anuj Kumar, followed by a group song 

performed by the women participants. The programme concluded with a vote of thanks delivered 

by Mr. Prashant Kumar, TGT WE, KV KR Puram, Bengaluru. 

 

Assembly Session 

The morning assembly was conducted by Group 4 (Tech Builders). The group presented a special 

item dedicated to Independence Day and shared highlights from the previous day’s sessions. 

 

School Kitchen Garden 

Sh. S. A. Bhende, TGT WE, KV No.2 Belagavi, discussed the objectives of a school kitchen 

garden, the tools and equipment required, soil preparation, and vermicomposting. He also 

explained seed sowing, transplanting seedlings, and planning techniques. The session closely 

followed the Kaushal Bodh textbook for Class VI and offered practical strategies for 

implementing kitchen gardens in schools. 

 

Plant Nursery 

Sh. Kistaiah Ausali explained the process of establishing and managing a plant nursery. He 

highlighted the steps for nursery management, suitable plant examples, and methods to maintain 

eco-friendly nurseries in limited spaces. The session concluded with practical insights into plant 

propagation. 

 

Recycling Plastic – Making a Rotating Bird 

KV No.1 Jalahalli, Bengaluru, demonstrated how to make a rotating bird using old pens and 

refills. The activity emphasized creative reuse of discarded plastic waste to create decorative, 

wind-driven models, promoting environmental awareness and innovation. 

 

LCD Interfacing with Arduino and Vocational Lab Setup 

Sh. G. V. Prasad, KV CRPF Yelahanka, Bengaluru, conducted a practical session on interfacing a 

16x2 Liquid Crystal Display (LCD) with Arduino to display text and data. He also guided 

participants on establishing vocational labs, outlining required equipment and applications of 

various tools. 

 

AI Frameworks and Applications (AI, AI Agents, and Agentic AI) 

Mr. Prashant Kumar, TGT WE, KV KR Puram, Bengaluru, introduced participants to AI 

frameworks, including voice-based ChatGPT interactions. A practical exercise demonstrated 

adding names to photos using HTML coding, highlighting simple yet effective ways to integrate 

AI and digital tools into teaching practices. 

 

 

 

 



 

 

 

UNDERSTANDING VOCATIONAL SKILLS FOR WORK 

EDUCATION 
 Mr. PRASHANT KUMAR 

TGT(WE) 

KV KR PURAM 

 

➢ Understanding Vocational Skills in Work Education 

Vocational skills form the foundation of Work Education (WE), equipping learners with practical 

abilities, technical know-how, and problem-solving competencies. These skills help students 

connect theoretical knowledge with real-life applications and prepare them for the world of work. 

Work Education emphasizes: 

• Hands-on learning through tools, machines, and projects. 

• Skill-building that supports employability, entrepreneurship, and life-long learning. 

• Values of dignity of labour, teamwork, and responsibility. 

 

➢ Importance of Vocational Skills in Modern Education 

In the rapidly evolving 21st century, vocational skills have become a crucial pillar of holistic 

education. They: 

• Bridge the gap between education and employability. 

• Promote experiential learning and enhance creativity. 

• Foster self-reliance, problem-solving, and innovation among learners. 

• Support integration of STEAM (Science, Technology, Engineering, Arts, Mathematics) with 

real-life applications. 

• Enable students to appreciate the value of physical work and sustainable practices. 

Vocational skills not only empower students to pursue diverse career pathways but also develop 

their capacity to contribute meaningfully at home, in society, and in the workplace. 

 

➢ Curricular Goals as per Kaushal Bodh 

The NCERT’s Kaushal Bodh framework identifies four Curricular Goals (CGs): 

• CG-1: Develop in-depth basic skills and allied knowledge of work and associated 

materials/procedures. 

• CG-2: Understand the place and usefulness of vocational skills and vocations in the world 

of work. 

• CG-3: Develop essential values while working across areas. 

• CG-4: Develop basic skills and allied knowledge to run and contribute to a home. 

 

4. Learning Outcomes (Sample) 

CG-1: Skills and Procedures 



• Selects tools appropriate for a specific task. 

• Uses tools correctly to complete a task. 

• Demonstrates stepwise processes for task completion. 

• Develops time-based plans for tasks. 

• Prepares materials and equipment for use. 

• Follows safety protocols. 

CG-2: Understanding Vocation 

• Explains the importance of vocations in the world of work. 

• Identifies personal interests in vocational areas. 

• Demonstrates how prior knowledge supports tasks. 

• Identifies quality and quantity criteria for evaluating products. 

CG-3: Values in Work 

• Observes and asks relevant questions during demonstrations. 

• Shows respect for people engaged in physical labour, irrespective of gender. 

• Collaborates with peers and helps during difficulties. 

• Revisits/reworks tasks for improvement. 

• Explores alternative uses of tools and materials. 

• Shows willingness and enthusiasm for physical work. 

CG-4: Contribution at Home 

• Identifies vocational skills relevant to home settings. 

• Applies basic skills for daily life tasks (gardening, repairs, cooking, etc.). 

 

➢ Mnemonic for Easy Recall 

Perfect Actions Make Everyone Appreciate Every Work’s Value 

• Perfect → Performs procedures (CG1) 

• Actions → Approaches tasks (CG1) 

• Make → Maintains and handles (CG1) 

• Everyone → Explains contribution (CG2) 

• Appreciate → Applies skills (CG2) 

• Every → Evaluates and quantifies (CG2) 

• Work’s → Work values (CG3) 

• Value → Vocational skills at home (CG4) 

 

➢ Portfolio Development (Sample Framework) 

A student portfolio in vocational education is a systematic record of learning, demonstrating 

progress in skills, creativity, and reflection. A sample portfolio may include: 

1. Personal Profile – Name, class, school, vocational interest. 

2. Learning Goals – Skills to be developed during the year. 

3. Task Records – Stepwise documentation of hands-on projects with photos/sketches. 

4. Reflection Notes – What was learned, challenges faced, improvements made. 

5. Assessment Rubrics – Based on curricular goals and learning outcomes. 

6. Feedback – From teachers and peers. 



7. Showcase of Work – Completed products, models, or project outcomes. 

This portfolio encourages self-assessment, creativity, and ownership of learning while serving as an 

evaluation tool for teachers. 

➢ Assessment and Evaluation (as per NCERT Guidelines) 

• Weightage Distribution: 

o Practical Work / Hands-on Activities: 60% 

o Portfolio / Project Records: 20% 

o Viva-Voce / Oral Reflection: 20% 

• Evaluation Focus Areas: 

o Correct use of tools and processes. 

o Creativity and problem-solving. 

o Collaboration and teamwork. 

o Safety and responsible handling. 

o Reflection on learning and values acquired. 

 

 

 

 

 



Skill Development 

Demonstrates 

exceptional mastery 

of vocational skills, 

with consistent 

improvement and a 

high level of 

proficiency. 

Shows strong 

hands-on skills, 

completes 

practical projects 

with precision and 

creativity. 

Good foundational 

skills, completes 

practical projects 

with some 

creativity. 

Demonstrates 

basic skills, 

completes 

projects with 

assistance. 

Struggles 

with hands-on 

tasks and 

needs 

significant 

assistance. 

Project-Based 

Assessment 

Independently 

completes complex 

projects with creativity, 

quality, and timeliness. 

Demonstrates critical 

thinking and problem-

solving. 

Completes projects 

from planning to 

execution with a 

clear, structured 

presentation. 

Completes projects 

with some 

organization, 

presentation is 

mostly clear. 

Requires 

guidance in 

project 

planning and 

execution, 

presentation is 

basic. 

Struggles 

with project 

completion 

and 

organization. 

Career 

Awareness 

Demonstrates 

excellent 

understanding of 

various career paths 

related to their 

vocational skills. 

Actively seeks 

opportunities for 

career exploration. 

Demonstrates a 

well-rounded 

understanding of 

career options 

related to 

vocational skills. 

Shows a good 

awareness of 

career options, 

with basic 

understanding of 

skill applications. 

Limited 

awareness of 

career paths, 

lacks insight 

into real-world 

applications. 

Minimal 

understanding 

of career 

options and 

vocational 

skills 

applications. 

  

Teamwork, 

Collaboration, 

and Social 

Skills 

Actively 

contributes to group 

work, 

communicates 

effectively, resolves 

conflicts, and 

supports others in 

achieving goals. 

Actively 

participates in 

group activities, 

showing excellent 

teamwork and 

social, ethical & 

interaction skills. 

Participates well in 

group activities 

with some 

teamwork skills. 

Limited 

participation in 

group 

activities, 

shows basic 

social skills. 

Avoids group 

activities, 

struggles with 

social 

interaction. 

Self and Peer 

Reflection 

Consistently 

demonstrates 

insightful self-

reflection, 

identifies strengths 

and areas for 

improvement, and 

sets goals for 

growth. Actively 

provides 

constructive 

feedback to peers. 

Provides insightful 

and constructive 

feedback on their 

own and peers’ 

work; shows a 

strong 

understanding of 

artistic intent and 

quality. 

Offers thoughtful 

feedback but may 

lack depth; reflects 

on their own work 

with some 

guidance. 

Provides basic 

feedback; may 

need prompts 

to reflect on 

their work or 

the work of 

others. 

Rarely 

reflects on 

their work or 

others'; 

provides 

minimal or no 

feedback and 

shows limited 

understanding 

of artistic 

intent. 



Criteria Excellent (3) Good (2) Needs Improvement (1) 

Safety 
Wears safety gear & 

follows all safety rules 
Minor safety lapse Unsafe practices 

 

Tool Use 
Handles soldering 

iron correctly 
Minor mistakes Poor handling 

Joint Quality Strong, clean joints Works but messy Weak/faulty joints 

Component 

Placement 
Correct & neat Slightly off Wrong placement 

Cleanup Cleans tools & area Partial cleanup No cleanup 

  

 



 

 

Suggestive Components of Portfolio :- 

•      Cover page with student details and title 

•          Step-by-step actions with photos/sketches 

•      Reflections, learning, challenges 

•   Peer and teacher feedback with remarks 

•     Optional add-ons: poems, sketches, certificates 

 

 

 

 

 



 
 

 
 

 



 
 

 

Learning Outcome (LO) Evidenced In Portfolio Assessed in Sheet 
Teacher 

Observation/Feedback 

LO1: Understand heat 

absorption and insulation 

Diagrams, explanation in 

reflection 
Understanding (5) 

Explains concepts 

confidently 

LO2: Use low-cost materials 

creatively 

Material list, step-by-step 

photos 
Creativity (5) 

Demonstrates innovation 

with materials 

LO3: Construct a working 

model 

Photo evidence, final 

demo 
Presentation (5) Builds model correctly 

LO4: Reflect on learning 

process 

Reflection page, speech 

bubbles 

Understanding (5), 

Remarks 
Shares thoughtful insights 

LO5: Collaborate with 

peers/family 

Step log mentions 

peer/family help 
Participation (5) 

Engages actively in group 

work 

LO6: Value sustainability 
Discussion, reflection 

comments 

Understanding (5), 

Remarks 

Mentions environmental 

benefits 

LO7: Maintain process 

documentation 

Neatly completed 

portfolio pages 

Presentation (5), 

Remarks 

Keeps work organized & 

complete 

LO8: Receive and act on 

feedback 

Changes based on 

peer/teacher comments 

Participation (5), 

Remarks 

Responds well to 

suggestions 

 



KAUSHAL BODH – VOCATIONAL EDUCATION & ASSESSMENT 

Mr. G. V. PRASAD 

TGT(WE) 

PM SHRI KV CRPF YELAHANKA 

 

➢ Introduction: The Need for Vocational Education 

Vocational education plays a crucial role in preparing students for future challenges 

by: 

• Enhancing employability and skill readiness. 

• Bridging the gap between theory and practice. 

• Promoting self-reliance, innovation, and entrepreneurship. 

• Cultivating the dignity of labour and value-based learning. 

 

➢ Goals of Kaushal Bodh 

The Kaushal Bodh initiative is aligned with NEP 2020 and NCF-SE 2023, and aims 

to: 

• Develop life skills through work education. 

• Introduce students to workplace culture and professional ethics. 

• Provide competency-based, value-oriented education. 

• Strengthen the link between education and employability. 

 

➢ Structure for Class VI (Foundation Level) 

At the middle school level, the programme emphasizes hands-on experiential learning 

with focus areas such as: 

• Agriculture & Gardening 

• Health & Hygiene 

• IT & Digital Literacy 

• Local Crafts & Trades 

Activities include group projects, practical tasks, and community-supported 

initiatives. Parents and local experts actively contribute, ensuring contextual and 

sustainable learning. 

 

➢ Methodology and Competency-Based Learning 

• Focus: Practical application over rote theory. 

• Integrated Competencies: Teamwork, critical thinking, creativity, and 

responsibility. 

• Pedagogy: Teachers act as facilitators; learning extends beyond classrooms 

with community participation. 



• Integration: Skills are linked with core subjects like Science, Mathematics, and 

Art to create holistic learning experiences. 

 

➢ Assessment Practices 

Assessment follows a 20% theory and 80% practical model, with both formative and 

summative approaches: 

• Formative Assessment: Observations, portfolios, group discussions. 

• Summative Assessment: Viva voce, role plays, demonstrations. 

• Rubrics: Used to ensure fairness and transparency. 

• Recognition: Special emphasis on creativity, innovation, and problem-solving. 

 

➢ Project Work (Three Mandatory Annual Projects) 

1. Work with Life Forms: e.g., gardening, animal care. 

2. Work with Materials/Machines: e.g., carpentry, tool handling. 

3. Work in Human Services: e.g., community welfare activities. 

These projects help students apply knowledge, build confidence, and experience the 

dignity of labour. 

 

➢ Skill Modules and Subjects (NCERT) 

• Middle School: 30+ modules (e.g., AI, Coding, Mass Media). 

• Secondary & Senior Secondary: Diverse skill subjects (e.g., Retail, IT, 

Agriculture, Healthcare). 

• Modules are flexible and encourage hands-on, competency-driven learning. 

 

➢ Challenges and Solutions 

• Infrastructure Gaps: Addressed through optimal use of vocational labs. 

• Teacher Training: Enhanced by capacity-building workshops. 

• Resource Availability: Supported by community partnerships and local 

networks. 

 

➢ Conclusion 

Kaushal Bodh nurtures future-ready citizens by integrating skills, values, and 

academics. By fostering innovation, collaboration, and self-reliance, the initiative 

prepares learners to thrive in real-life situations with confidence and dignity. 

 

 

 

 



SKILL ENRICHMENT IN VOCATIONAL EDUCATION 
 Mr. Hari Kumar A. 

 TGT (WE) 

 KV NAL Bengaluru 

Introduction 

The 21st century has brought rapid technological change and evolving job markets, 

transforming schools from centers of academic instruction into hubs of skill 

development. Vocational education, when integrated with 21st-century skills, 

empowers learners to adapt, innovate, and succeed in a dynamic world. 

 

Importance of 21st-Century Skills in Schools 

Modern workplaces demand more than theoretical knowledge. Skills like critical 

thinking, collaboration, digital literacy, and problem-solving are now foundational to 

professional success. 

“Skills cannot merely be taught—they must be acquired through practice, application, 

and real-world engagement.” 

 

Technological Revolutions: A Timeline 

1. 18th Century: Steam engine – powering industrial growth. 

2. 19th Century: Electricity and telegraph – revolutionizing industry and 

communication. 

3. 20th Century: Internet – enabling global connectivity. 

4. 21st Century: AI, Robotics, IoT, Drones, and Big Data – driving transformative 

change. 

Impact on Job Roles 

Technological shifts redefine professions: 

• Automated kiosks replacing ticket clerks. 

• Self-driving vehicles transforming transport jobs. 

• AI diagnostics reshaping medical imaging roles. 

 



NEP 2020 and 21st-Century Skills 

The National Education Policy (NEP) emphasizes: 

• Networking with peers and professionals. 

• Access to career-oriented courses (e.g., Coursera, edX). 

• Integrating emerging technologies into classrooms. 

 

Core 21st-Century Skills 

1. Language & Communication Skills – foundation of collaboration. 

2. Artificial Intelligence (AI): 

o Supervised Learning – predictions from labeled data. 

o Unsupervised Learning – pattern recognition. 

o Reinforcement Learning – feedback-driven improvement. 

3. Robotics – design and programming of autonomous machines. 

4. Internet of Things (IoT): sensors, connectivity, data processing, and interfaces. 

5. Drones (UAVs): applications in agriculture, logistics, and disaster relief. 

 

Why Integrate These Skills? 

Traditional education often falls short in preparing students for: 

• Jobs that didn’t exist a decade ago. 

• Fast-paced technological change. 

• Complex, interdisciplinary challenges. 

Benefits: 

• Better adaptability. 

• Higher employability. 

• Innovative approaches in education and industry. 

 

Jobs at Risk (Next 5 Years – WEF) 

Roles involving repetitive tasks (street vendors, data entry clerks, postal workers, 

bookkeepers, cashiers). Nearly 39% of current jobs may be automated. 

Emerging Opportunities (WEF) 



• Nursing & healthcare. 

• Agricultural consulting. 

• AI/ML engineering. 

• Big Data analysis. 

• Digital automation & graphic design. 

• Skilled modern construction. 

 

Strategies to Integrate 21st-Century Skills in Vocational Education 

1. Encourage collaboration through group projects. 

2. Promote curiosity and questioning in classrooms. 

3. Leverage digital tools for learning. 

4. Integrate arts for creativity. 

5. Apply inquiry-based learning. 

6. Foster innovation labs and design challenges. 

7. Strengthen communication through debates and presentations. 

8. Build resilience and adaptability. 

 

The 21st-Century Teacher 

A modern educator acts as a facilitator, mentor, and lifelong learner, who: 

• Adapts pedagogy to changing needs. 

• Seamlessly integrates technology. 

• Prepares students for jobs of the future. 

 

Conclusion 

The integration of 21st-century skills with vocational education is not optional but 

essential. By fostering adaptability, creativity, and technical proficiency, educators 

can prepare students for a future defined by change, innovation, and limitless 

opportunity. 

 

 



HANDS ON GENERATIVE AI TOOLS 

MR. JOYCE SABASTIAN 

TGT(WE) 

KV AFS YELAHANKA 

 

Part A — Train your model (Mobile vs Mic) in Teachable Machine 

1. Open Teachable Machine → Image Project → Standard image model. 

Teachable Machine 

2. Make two classes: 

o Mobile (phone) 

o Mic (microphone) 

3. Add training images (webcam or upload): ~30–50 varied images per class 

(angles, lighting, background). 

4. Click Train Model. 

5. When done, click Export Model → TensorFlow.js → Upload (hosted) → Copy 

the Share/Model URL. 

o We’ll paste this URL inside the RAISE Playground so your blocks can 

use the model. 

Tip: Include some “negative” images in each class (e.g., hands, desk) to reduce false 

positives. 

 

Part B — Set up the RAISE Playground (blocks) 

1. Open RAISE Playground and click Open playground. 

playground.raise.mit.edu 

2. Add the Teachable Machine extension (bottom-left “Add extension”). You’ll 

see new blocks like load model, get prediction, label, confidence. (RAISE 

describes Teachable Machine blocks as part of its AI extensions.) MIT Media 

Lab 

3. Also add the Text-to-Speech extension (same place). (Many RAISE tutorials 

use TTS alongside AI blocks.) Medium 

4. Add the Video/Camera extension if prompted so the model can “see”. 

 

Part C — Wire the blocks (predict + speak) 

Below is a clear, minimal script. You’ll create one sprite (the Cat is fine) and 

put this code on it. 

Setup (run once) 

• when green flag clicked 

→ turn video on (set to “on” / “0 transparency”) 

→ Teachable Machine → load model from URL (paste the model URL you 

https://teachablemachine.withgoogle.com/?utm_source=chatgpt.com
https://playground.raise.mit.edu/?utm_source=chatgpt.com
https://www.media.mit.edu/posts/ai-blocks/?utm_source=chatgpt.com
https://www.media.mit.edu/posts/ai-blocks/?utm_source=chatgpt.com
https://medium.com/%40jahnaviyadav176/scrap-trap-8dbf69274b70?utm_source=chatgpt.com


copied) 

→ set language (Text to Speech) to a voice you like (e.g., “en-US”). 

Loop (predict continuously) 

• forever 

→ Teachable Machine → get prediction (from video) 

→ set [detected v] to (label) 

→ set [conf v] to (confidence) 

→ if <(conf) > 0.75> then 

→ say (join "I see " (detected)) for 1 sec 

→ Text to Speech → speak (detected) 

That’s it. The sprite will say and speak “Mobile” when it sees a phone and “Mic” 

when it sees a microphone. 

Why a 0.75 threshold? It avoids jittery predictions; tune if your model is 

confident/uncertain. 

 

Part D — Make it only speak when the label changes (optional but recommended) 

Add a variable lastLabel. Replace the “if” part with: 

• if <(detected) ≠ (lastLabel) and (conf > 0.80)> then 

→ set [lastLabel v] to (detected) 

→ speak (detected) and say it on screen. 

This prevents the sprite from talking nonstop while the same object stays in view. 

 

Part E — Quick UI/UX polish 

• Show confidence on stage: 

→ *set [display v] to (join (detected) (join " (" (join (round ((conf)100)) 

"%)"))) 

→ say (display) 

• Hotkeys: add: 

o when [space] key pressed → toggle video on/off 

o when [c] key pressed → clear lastLabel (forces a new announcement) 

 

Part F — Troubleshooting 

• Model won’t load 

o Double-check you exported TensorFlow.js → Upload (hosted) and 

copied the hosted model URL, not the download zip. Teachable Machine 

• Predictions flicker 

o Add a confidence threshold (0.7–0.9) and the lastLabel check. 

o Add more/better training images; balance both classes (Mobile vs Mic). 

• No camera 

https://teachablemachine.withgoogle.com/?utm_source=chatgpt.com


o Browser permission: allow camera for playground.raise.mit.edu. 

• No voice output 

o Make sure Text-to-Speech extension is added and your browser tab isn’t 

muted. (RAISE projects commonly pair AI blocks with TTS for 

feedback.) Medium 

 

Bonus — Create a scoreboard 

Count correct detections for a timed demo: 

• Variables: timer, score 

• when green flag clicked → set [timer] to 30 → repeat 30 (wait 1 sec, change 

timer by −1) 

• Inside your “if label changed & conf>0.8” block, add change [score] by 1 and 

play sound. 

 

Where this comes from 

• RAISE Playground: block environment with AI extensions (incl. Teachable 

Machine). playground.raise.mit.eduMIT Media Lab 

• Teachable Machine: quick, no-code training for image models; export to web 

(TensorFlow.js). Teachable Machine 

• TTS with RAISE/Scratch-style projects: commonly used alongside AI blocks 

to give spoken feedback. Mediu 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://medium.com/%40jahnaviyadav176/scrap-trap-8dbf69274b70?utm_source=chatgpt.com
https://playground.raise.mit.edu/?utm_source=chatgpt.com
https://www.media.mit.edu/posts/ai-blocks/?utm_source=chatgpt.com
https://teachablemachine.withgoogle.com/?utm_source=chatgpt.com
https://medium.com/%40jahnaviyadav176/scrap-trap-8dbf69274b70?utm_source=chatgpt.com


ATAL TINKERING LAB 
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KV RAIL WHEEL FACTORY 
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ATL or Atal Tinkering Lab is an initiative by NITI Aayog under the stewardship 

of Atal Innovation Mission (AIM) to give a boost to the innovation ecosystem 

in the country. The objective behind setting up an ATL to create an ecosystem 

fueled by curiosity, creativity, and imagination in India. 

 

What is the introduction of ATL lab? 

It is a lab to encourage people to explore alternatives and create options that 

did not exist before. MORE ABOUT ATAL TINKERING LABS - by National 

Institution for Atal Tinkering Labs is a national level program Transforming 

India (NITI Aayog) - the premier policy 'Think Tank' of the Government of 

India. 

 

The applicant school would have to provide at least 1,500 Sq. Ft. of built up 

space. Applicant schools from hilly / Himalayan and island states, UTs would 

have to provide at least 1,000 Sq. 

 

An Atal Tinkering Lab provides activity-based learning in the identified 

schools across the country where young minds can give shape to their ideas for 

societal problems. 

 

One time establishment cost of up to Rs. 10.0 lakh has been provided for each 

ATL. 

Atal Tinkering Lab [ATL] 

1. Design and set-up a tinkering facility with state of the art electronics and 

machinery. 

2. Provide an experiential learning syllabus based on topics from regular 

academics. 

3. A team of experienced engineers to train students in ideation, design thinking, 

computational thinking and physical thinking. 

Tinkerly provides a set of four packages for schools that are created as per the 

guidelines of NITI Aayog. 



The objective of this scheme is to foster curiosity, creativity, and imagination in 

young minds; and inculcate skills such as design mindset, computational thinking, 

adaptive learning, physical computing etc. Read More about ATL. 

 

The objective of this scheme is to foster curiosity, creativity, and imagination in 

young minds; and inculcate skills such as design mindset, computational thinking, 

adaptive learning, physical computing etc. Read More about ATL. 

 

1. Go to the AIM website https://www.aim.gov.in/, the link 

(https://www.aim.gov.in/atl/) for the My ATL dashboard is available under the Atal 

Tinkering Labs drop-down.  

2. Log onto the system using your existing user credentials, “ATL Application ID” 

and “Password”. 

 

Atal Tinker Lab(ATL) is a workspace where young minds can give shape to 

their ideas through hands on do-it-yourself mode, and learn innovation skills. 

Young children will get a chance to work with tools and equipment to 

understand the concepts of STEM (Science, Technology, Engineering and 

Math). 

https://aim.gov.in/atl-curriculum.php 

For ATL Packages the link can be used to download the reference document-  

 
 

 

Tools and Accessoies:-  

• Tools: Garden trowels (10), hand cultivators (10), gardening shears (5), hedge 

shears (5), spades small/big (5), pickaxes small/big (5), hammers (5), cutting 

pliers (5), crowbars (5), hand saw/hack saw (5), cutters (5). 

• Materials & Accessories: Watering cans/hose pipes (10), rubber gloves (10 

pairs), plant labels (20), spray bottles (10), wheelbarrows (2), bins/tarpaulin 

(5), old PVC pipes/sticks/poles/strings (sufficient), potting soil (50 kg), 

seeds/seedlings (5 packets/50 seedlings), neem leaves (2 kg), manure (10 kg), 

organic mulch (2 kg). 

 

https://aim.gov.in/atl-curriculum.php
https://drive.google.com/file/d/1B14eLwW_IYzH-25Rw-UyYG_wO9QVeBoE/view?usp=drive_link


2. Carpentry & Mechanical Tools 

• Hand Tools: Chisels (5), measuring tapes (5), jack planes (5), carpenter vice 

(2), clamps (2), sharpening stones (5), hammers (5), try squares (5), poker (5), 

pincer (5). 

• Power Tools: Hand drilling machines (5), cordless screwdriver sets (2), power 

drilling machines (2), wood cutting machines (2). 

• Other Equipment: Spanner set (1), file set (1), hang guides (5), sandpaper 

(25), hack saws (5). 

 

3. Electrical Tools & Equipment 

• Basic Tools: Multimeters (5), cutting pliers (5), testers (10), screwdrivers 

star/flat (5 each), continuity testers (5), wire cutters (5), nose pliers (5), wire 

gauges (5), test lamps (5). 

• Appliances & Testing Boards: Appliance testing boards (5), switch 

boards/extension boards (5), wiring boards (10), electric irons (5), mixer 

grinder (1), immersion heaters (5), water purifier (1), refrigerator (1), washing 

machine (1), induction cooker (1). 

• Plumbing & Safety: Pipe wrenches (2), adjustable wrenches (2), hacksaw 

frame with blade (1), goggles (5), sealing tape (1), threader set (1), high 

insulation gloves (2 pairs), cold chisels (2), DE spanner set (1). 

 

4. Soldering & Electronics Kits 

• Soldering Tools: Soldering irons 25W (5), soldering wire (5), flux (5), stands 

(5), tweezers (5), soldering boards (5), de-soldering pumps (5), PCBs (5). 

• Basic Components: 555 Timer IC (5), breadboards (small/full size) (5 each), 

LED matrix modules (5), 7-segment displays (5), LEDs (20 each in red, green, 

yellow, white), capacitor boxes (5), resistor boxes (5), servo motors (5), 

buzzers (5), rechargeable batteries (5), jumper cables (various types). 

• Sensors & Modules: LDR, gas sensors (5 each), Arduino Uno (5), DHT11 

sensors (5), sound playback modules (5), soil moisture sensors (5), DC motors 

(5), propellers (5). 

 

5. Robotics & IoT Kits 

• IoT Kit Components: ESP32 board (1), raindrop sensor (1), voice recognition 

module (1), laser module (1), temperature & humidity sensor (1), PIR sensor 

(1), RFID module (1), photoresistor sensor (1), LCD module (1), servo motor 

(1), RGB LED module (1), battery holder (1), jumper cables. 

• Robotics Kits: Smart Robot Car Kit, Rover Kit, DIY Moisture & Temperature 

Detection Robot. 



 

6. Pottery Tools 

• Pottery Wheel: Mini electric pottery wheel (1) with detachable basins, 

shaping tools, clay. 

• Professional Pottery Tools Kit: For sculpting, scraping, cutting, detailing, 

shaping, trimming. 

 

 

Smart Home Automation – Retrofit Method 

Introduction 

Retrofit home automation allows adding smart control to existing electrical systems 

without changing the old wiring. This approach is cost-effective, quick to set up, and 

ideal for upgrading homes, offices, or classrooms in stages without wall-breaking or 

heavy rewiring. 

 

What is Retrofit Wiring? 

Retrofit wiring means integrating smart devices into the current electrical setup using 

the existing wiring for power while enabling wireless control through mobile apps or 

voice assistants. 

Advantages: 

• No wall breaking or major rewiring 

• Lower installation cost 

• Quick and easy setup 

• Works with existing wiring 

• Can be upgraded step-by-step 

 
 



 

Types of Retrofit Devices 

1. Smart Switches – Replace traditional wall switches and add wireless control. 

 
2. Smart Plug Adapters – Plug-and-play devices for remote control of 

appliances. 

3. In-Wall Retrofit Modules – Installed behind existing switches to add smart 

features without changing the switch. 

4. Smart Bulbs – Wi-Fi-enabled bulbs controlled via app or voice command. 

5. IR/RF Controllers – Control devices like TV or AC remotely. 

6. Sensor Lights – Automatic lighting based on motion detection. 

 



 
 

Basic Working Principle 

Mobile App / Voice Command → Wireless Signal → Smart Device → Electrical 

Load 

• No extra wiring is needed for control; only existing wires supply power. 

 

 

Examples of Retrofit Automation Devices 

1. Smart Switch Retrofit Wiring 

• Before: Live → Switch → Load → Neutral 

• After: Live → Smart Switch → Load → Neutral (with wireless control built-

in) 



2. Motion Sensor Light 

• Uses PIR (Passive Infrared) sensor to detect movement. 

• Lights turn on when motion is detected and turn off after a set time. 

• Ideal for corridors, restrooms, and classrooms to save energy. 

3. Smart Plug 

• Plugs into a standard socket; appliance plugs into the smart plug. 

• Connects via Wi-Fi for remote control, scheduling, and automation. 

• Can monitor energy consumption. 

• Works with Alexa, Google Assistant, Siri for voice control. 

 
 

Safety Precautions 

• Switch off main power before installation. 

• Ensure devices are compatible with India’s 230V AC supply. 

• Avoid handling devices with wet hands. 

• Internal wiring should be done only by trained personnel. 

 

Educational and Practical Benefits 

• Demonstrates IoT concepts, coding, and automation principles. 

• Helps students understand real-world electrical integration. 

• Can be scaled from single-room setups to entire buildings. 

Summary 

Retrofit home automation offers a fast, easy, and low-cost method to turn any 

traditional setup into a smart, connected system. It blends practical electrical 

knowledge with modern IoT skills, making it an excellent project for vocational 

education and future-ready learning. 

 



ESP 32 HANDS ON ACTIVITIES 
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ESP32 and Its IoT Applications 

 
 

Overview 

The ESP32 is a powerful microcontroller with Tensilica Xtensa 32-bit dual-core CPU 

(up to 240 MHz, 600 DMIPS), operating at 3.3V with built-in Wi-Fi (802.11 b/g/n/e/i) 

and Bluetooth v4.2 (BR/EDR & BLE). It comes with 448 KB ROM, 520 KB SRAM, 

additional RTC memory, and supports peripherals like GPIO, PWM, ADC, DAC, 

UART, SPI, I²C, CAN, and touch sensors. 

 
 



 

 

 



Setting Up ESP32 in Arduino IDE 

1. Install Arduino IDE – Ensure latest version. 

2. Add ESP32 Board URL – In File → Preferences → Additional Board Manager 

URLs add: 

https://espressif.github.io/arduino-esp32/package_esp32_index.json 

3. Install ESP32 Board – Tools → Board → Board Manager, search and install 

ESP32. 

4. Select Board & Port – Choose ESP32 Dev Module and correct COM port. 

5. Test with Blink Sketch – Verify setup by blinking onboard LED. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

#define LED_PIN 2 // Onboard LED for ESP32-S series boards 

 

void setup() { 

pinMode(LED_PIN, OUTPUT); // Set LED pin as output 

} 

 

void loop() { 

digitalWrite(LED_PIN, HIGH); // Turn LED ON 

delay(500); // Wait 500ms 



digitalWrite(LED_PIN, LOW); // Turn LED OFF 

delay(500); // Wait 500ms 

} 

Weather Station with DHT11 

 
 

IoT Smart Garden Project (ESP32 + DHT11 + Soil Moisture Sensor) 

• DHT11 Sensor – Measures temperature (°C) and humidity (%). 

• Soil Moisture Sensor – Monitors soil water content. 

• Code Structure: 

o #define for pin naming. 

o Create sensor object (DHT dht(...)). 

o setup() – Initialize serial monitor & sensors. 

o loop() – Continuously read and display sensor data with delays to 

prevent overload. 

• Extensions: 

o Automate watering with pump control. 

o Connect to cloud (Blynk, ThingSpeak) for remote monitoring. 



o Analyse long-term environmental data. 

 

Simulation with Wokwi 

• Wokwi.com allows testing Arduino, ESP32, and IoT projects online without 

hardware. 

• Features: Virtual components, real-time serial monitor, cloud integration, 

debugging tools. 

• Applications: LED blinking, temperature monitoring, IoT MQTT 

connectivity, robotics. 

 

IoT Application Examples 

• Temperature & Humidity Monitoring – Remote weather station with alerts. 

• Smart Garden – Automated irrigation based on soil moisture. 

• Air Quality Measurement – Monitor pollution levels using sensors. 

• Home Automation – Control devices via Wi-Fi or Bluetooth. 

 

Conclusion 

ESP32 is a versatile and cost-effective microcontroller ideal for IoT projects. Its 

built-in connectivity, wide range of compatible sensors, and compatibility with 

Arduino IDE make it suitable for educational, hobby, and industrial applications. 

Tools like Wokwi enable safe and cost-free experimentation before real-world 

deployment. 

 

 

 

 

 

 

 

 

 

 



SCRATCH GAME DEVELOPMENT 
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1. Player 1 (Shooter) 

1. Click Choose a Sprite → select Paint. 

2. In the Paint editor: 

o Select the Circle / Rectangle and Line tool. 

o Draw a small rectangle (like a spaceship base or a cannon). 

o Add a triangle on top (to look like the shooter’s tip). 

o Use a solid color (e.g., blue). 

3. Name the sprite Player 1. 

4. Place it at the bottom center of the stage (y: -150). 

 

2. Bullet 

1. Click Choose a Sprite → Paint. 

2. In the Paint editor: 

o Use the circle tool (or rectangle tool) to draw a tiny dot/rectangle. 

o Fill it with a bright color (e.g., red or yellow). 

3. Name the sprite Bullet. 

4. Make it small (resize if needed). 

 

3. Enemy 

1. Click Choose a Sprite → Paint. 

2. In the Paint editor: 

o Draw a simple shape (circle or square). 

o Add eyes or patterns to look like an alien/enemy. 

o Use a contrasting color (e.g., green). 

3. Name the sprite Enemy. 



4. Place it at the top of the stage (y: 150). 

 



 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



IMPLEMENTATION OF VOCATIONAL EDUCATION 

(KAUSHAL BODH – CLASSES 6 TO 8) 
Dr. C S ANUPAMA 
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Introduction 

Vocational Education under Kaushal Bodh aims to bridge the gap between 

theoretical learning and practical application. By focusing on life skills, 

employability, and experiential learning, the curriculum prepares students for 

real-world challenges. However, its implementation requires careful planning, 

teacher preparedness, and appropriate assessment methods. The following 

sections highlight practical issues and strategies for effective execution. 

 

1. Teaching in Block Periods 

Vocational education requires extended time slots to complete hands-on activities 

and projects. Unlike traditional subjects, practical tasks such as gardening, 

carpentry, or digital literacy cannot be confined to short 35–40 minute classes. 

• Suggested Approach: Allocate block periods (90–120 minutes) once or 

twice a week. 

• Benefits: Provides uninterrupted time for project completion, group 

discussions, and reflection. 

• Implementation: Schools may adjust timetables or use bagless days as 

recommended under NEP 2020. 

 

2. Writing Answers in Activity Book 

The Activity Book serves as the core resource for documentation, reflection, and 

assessment. Students often face challenges in writing detailed answers due to lack 

of guidance. 

• Suggested Approach: 

o Teachers should conduct guided writing sessions. 

o Encourage students to use diagrams, flowcharts, and simple notes 

rather than long paragraphs. 

o Promote self-reflection (What did I learn? How can I apply it?). 

• Outcome: Helps in recording progress, building responsibility, and linking 

theory with practice. 

 

3. Method of Practical Activities & Projects 



Practical sessions are the heart of vocational education. However, variation in 

resources and expertise can create gaps in execution. 

• Suggested Approach: 

o Adopt a project-based learning (PBL) approach with clear step-by-

step instructions. 

o Use locally available materials to minimize cost. 

o Involve community experts (farmers, artisans, IT professionals). 

o Ensure safety measures while handling tools. 

• Outcome: Students develop problem-solving, creativity, and application-

based learning. 

 

4. Conducting Tests and Assessment Method 

Assessment must focus on skills and competencies, not just theoretical recall. 

• Formative Assessment: Ongoing teacher observations, portfolios, group 

tasks, peer reviews. 

• Summative Assessment: 

o Oral presentations and viva voce 

o Demonstrations of practical work 

o Role play/simulations 

o Situational tests (flowcharts, case-based MCQs) 

• Weightage: Recommended 20% theory and 80% practical, ensuring learning 

by doing. 

5. Use of Rubrics and Place in Report Card 

Rubrics provide transparent and structured evaluation. They help both teachers 

and students understand the expected outcomes. 

• Suggested Rubric Parameters: 

o Practical execution (accuracy, safety, creativity) 

o Teamwork and collaboration 

o Communication and presentation skills 

o Reflection in activity book 

• Integration in Report Card: Vocational education should have a dedicated 

section in report cards, highlighting skills, competencies, and attitudes 

developed, not just marks. 

 

6. Addition of New Activities 

To maintain student engagement, activities must evolve with time and technology. 

• Suggestions for New Activities: 

o Basic coding and robotics (introductory level) 



o Local entrepreneurship projects (e.g., eco-friendly products, small 

business plans) 

o Energy conservation/renewable energy projects 

o Community service initiatives 

• Outcome: Keeps learning relevant, innovative, and aligned with NEP 2020’s 

emphasis on future skills. 

 

7. Use of Vocational Lab 

A dedicated Vocational Lab enhances experiential learning. It should be flexible and 

multipurpose, supporting gardening, IT, crafts, and other activities. 

• Essential Features: 

o Modular workstations 

o Digital tools (computers, internet access) 

o Basic carpentry/hand tools 

o Storage for raw materials and student projects 

• Benefit: Encourages a culture of experimentation and innovation in a safe 

environment. 

 

8. Teaching of Class 9 and Above 

Transitioning vocational education from middle school (6–8) to secondary level (9–

12) requires continuity. 

• Challenges: Increased curriculum load, limited time, specialized skill 

requirements. 

• Solutions: 

o Offer elective skill subjects (IT, Agriculture, Tourism, Retail, AI, etc.) 

aligned with NCERT framework. 

o Provide career guidance sessions linking vocational skills to future 

opportunities. 

o Strengthen industry partnerships for exposure and internships. 

Conclusion 

Effective implementation of vocational education in middle and secondary 

schools requires planning, community involvement, and teacher training. 

Assessment must prioritize skills over rote learning, while activities should 

be student-centered, practical, and locally relevant. By overcoming 

challenges in infrastructure, assessment, and pedagogy, vocational education 

can truly enhance employability, foster entrepreneurship, and instill dignity of 

labour among students. 
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